Abstract: The nature of explosive equipment failures, and the rate of serious burn injuries in the electrical industry has been studied for many years. Detailed investigation into the arc flash phenomena by many researchers has led the NFPA to adopt arc flash guidelines in NFPA-70E (2000) for work on or near energized electrical equipment. The 2002 National Electric Code also adopted Arc Flash Hazard labeling requirements. In September of 2002, IEEE-1584 “IEEE Guide For Performing Arc Flash Hazard Calculations” was released, providing the detailed equations for determining arc flash energies. Proposed NFPA-70E (2003) due for adoption in May 2003 enhances the original 70E guidelines and adopts IEEE-1584 as the basis for determining arc flash energies.

Arc-flash hazard studies require knowledge of both the electrical power system in a facility, and the systems electrical protection. Arc flash studies can be considered a continuation of the short circuit and coordination aspects of a power system, since the results for each are required to assess flash hazards. The effort required to perform an arc hazard assessment is greatly reduced the closer the integration between the short circuit, protective device coordination, and the arc-flash software.

This paper provides a guideline for performing an arc-hazard assessment using power system analysis software. All references and examples in this paper refer to EasyPower software. In order to minimize space requirements, it will assume the user has the power system modeled in EasyPower, and has performed a short circuit and protective device coordination study.

Step-1 Data Collection And System Modeling

The greatest single effort in performing an arc-flash study is in data collection. For a system with up to date one-line diagrams, data collection can take from 25-40 percent of the study effort. The main difference between an arc hazard assessment and other studies is that you may need to model the system in more detail, increasing the data collection time and study effort. If the equipment has the potential to be worked on while energized, it should be assessed. This includes branch circuits in data centers, panels and switchboards being served by smaller (<500 kVA) transformers at 480 volts. Panels and switchboards rated 240 volts or less can be ignored if the service transformer is less than 125 kVA. See Figure-1.

In years past, it was common practice for some engineers to exclude cable impedances, and sometimes equipment resistance in the system model to insure the highest possible short circuit values when calculating withstand duties for equipment. This is not recommended for several reasons. First, EasyPower can accurately model all equipment types in detail, so there are no reasons for minimized models or built in safety factors. Secondly, conductor impedance’s and X/R ratios should be modeled for all equipment in order to obtain realistic short circuit values. To assist the model in providing higher short circuit currents may actually be non-conservative when assessing arc-flash hazards, resulting in decreased worker safety.

It should be noted that the study results will only be as good as the system model. Every effort should be made to model the actual equipment as found in the field.
Step-2 System Operating Modes

For plants with simple radial service from the utility, only one mode of operation typically exists – normal. However, for larger plants, there may be multiple modes of operation. These may include:

- Multiple utility sources that are switched in or out.
- Multiple generator sources that are operated in parallel or isolated depending on the system configuration.
- Emergency operating conditions. This may be with only small backup generators.
- Maintenance conditions where short circuit currents are low and trip time high.
- Parallels feeds to Switchgear or MCC’s.
- Tie breakers which can be operated open or closed.
- Large motors or process sections not in operation.

What is important to realize is that each one of these conditions may change the level of short circuit current, which in turn changes the clearing time of the protective devices. These changes can have a significant impact on the arc-flash hazard and the PPE requirements for each piece of equipment.
In Figure-2, an example system with maximum available short circuit current is shown. Both utility sources are on line and the switchgear tiebreaker is closed.

In Figure-3, an example system with minimum short circuit current is shown. Both utility sources are on line and the switchgear tiebreaker is open, reducing the available short circuit current on each bus. The examples above consider a double ended utility tie system, but the application applies to low voltage systems with tie breakers or where emergency generation provides stand alone power or works in parallel with the normal system.
The time current curve (TCC) of Figure-4 shows an extremely inverse relay characteristic, where the trip time increases as the current decreases. Decreased short circuit current (opening a tie breaker, removing generation, etc.) can cause longer trip times and may increase incident energies and the resulting arc-flash hazard.

In summary, Arc Flash assessment should include each operating mode for the power system to insure correct incident energies are calculated for all system conditions.
Step-3 Working Distance and Threshold Boundaries
Before running the actual analysis portion of the study, the user should determine the parameters on which the study will be based. These include, working distances, units of measurement, threshold boundaries, and the calculation standard or the “equations” for the analysis.

Working Distance
The arc flash boundary and associated protection requirements are based on the incident energy levels available to the persons chest or face, not the hands or arms. The degree of injury depends on the percentage of the person’s skin that is burned, and the critical nature of the burn. Obviously, the head, and chest areas are more critical to survival than fingers or arms.

Appropriate working distances for most operations can be calculated by placing your elbow at your side and extending your hand to the equipment. A typical average for this distance is 18 inches. By extending the arm to the full out position, this can be increased to 24-28 inches for most people. See Figure-5.

Figure-5

EasyPower provides up to five (5) working distances for each voltage level. This allows the user to develop a safety program where distances can be modified for a specific operation or maintenance function, allowing easy standardization of clothing levels and safety benefits. Notice that for higher voltage levels, greater distances may be used to indicate hot stick operation.

Unit of Measure
Working distances, and arc flash boundaries are calculated and displayed in various units of measure including, inches, feet, mm, or meters. Select the appropriate unit that will be easily recognized by workers and adhered to. Critical safety programs such as arc flash hazards should not confuse workers...
with units of measure. Examples: For US markets most workers are more familiar with inches and feet than mm, and meters. The opposite would be true for facilities in Europe.

See Figure-6

**AF Boundary**

The arc flash boundary is defined as the distance from the arc source where the onset of second degree burns can occur. This is typically defined by medical researchers as 1.2 cal/cm² or 5.0 Joules/cm². Some research indicates that up to 1.5 cal/cm² can be used for exposure less than 6 cycles (0.1 seconds).

EasyPower provides the user with options based on clearing times less than 0.1 seconds and for clearing times greater than 0.1 seconds. EasyPower automatically determines the operating time from the system protection characteristics, or from user defined times during the arc flash calculation.

The arc flash boundary incident energy must be set at the minimum energy level in which a second-degree burn could occur. Do not increase the levels from those shown in the dialog box. Reduced values may be used based on your safety or insurance requirements.

**Calculation Standard**

EasyPower provides four calculation standards, NFPA-70 (2000), proposed NFPA-70E (2003), IEEE-1584, and EasyPower’s enhanced version of IEEE-1584. EasyPower’s extensive research has corrected some of the potential inconsistencies in the 1584 standard which may lead to non-conservative results. We recommend that the enhanced version of 1584 be used or NFPA-70E (2003) to insure more conservative results.
Threshold Incident Energy

Incident energy is defined as the amount of energy impressed on a surface, a specific distance away from the source during an electrical arc event. It is sometimes called surface energy density. Incident energy is measured in joules per centimeter squared ($J/cm^2$) or in calories per centimeter squared ($cal/cm^2$).

EasyPower provides a threshold incident energy level for different voltage ranges. If the incident energy level of a particular device is above the threshold, the device will be highlighted on the one-line as an immediate danger (detailed user reports are also provided). See Figure-7.

Electrical workers and safety managers can use this threshold to immediately identify areas where current personal protective equipment (PPE) standards will not provide the required safety margins.

![Figure-7](image)

For this 480-volt system, the incident energy threshold was set at 4.0-cal/cm² or a PPE of 1 as defined in NFPA-70E (2003). All protective devices with let through energies above this value are highlighted red indicating danger. Notice that for work on this switchgear, a minimum PPE of 3 is required for all work except on the load side of breaker BL-3. The following Table from the proposed NFPA-70E (2003) lists PPE requirements in relation to incident energy.

<table>
<thead>
<tr>
<th>NFPA-70E 2003 Proposed PPE Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Risk Category</td>
</tr>
<tr>
<td>---------------</td>
</tr>
<tr>
<td>Class #0</td>
</tr>
<tr>
<td>Class #1</td>
</tr>
<tr>
<td>Class #2</td>
</tr>
<tr>
<td>Class #3</td>
</tr>
<tr>
<td>Class #4</td>
</tr>
<tr>
<td>Class #5</td>
</tr>
</tbody>
</table>
Step-4 Protective Device Coordination Study

After the system model is built, and the operating modes are determined, the following procedures are used to determine arcing fault incident energies.

a) Determine bolted fault (short circuit) currents at each bus in the system.

b) Use calculated currents to perform a protective device coordination study and develop system relay and direct acting trip (DAT) settings. Settings are typically determined by plotting protective devices on time current curves (TCC’s).

c) Determine arcing fault currents at each bus in the system using IEEE-1584 or NFPA-70E equations. Note that different equations or multipliers are used for voltages <1.0kV, 1.0kV<kV<15.0kV, open air, inside box, and various system parameters.

d) Apply arcing currents, and breaker/relay trip times to each device to determine arc hazard incident energies, arc-flash boundaries, working distances, and PPE requirements.

The steps shown would be required for performing the calculations with power analysis software as well as by hand. Depending on the system size (number of buses) performing this procedure can be extremely time consuming or nearly impossible without software tools. Only software based tools that provide true, seamless integration of short circuit, protective device coordination and arc flash hazard analysis can provide accurate information that can provide for better worker protection and reduced productivity losses due over specification of gear. EasyPower’s inherent one-line/analysis integration eliminates the separate steps required by other programs and integrates the short circuit, protective device, and arc hazard functions, greatly reducing the time, an effort to perform the analysis.

Protective Device Coordination Using EasyPower

Using EasyPower, the process will be broken down into two steps for clarification purposes.

a) System wide protective device coordination.

b) Arc flash calculations.

While this guide does not provide the details for performing a protective device coordination study, it should be stressed that this study is the cornerstone to providing accurate arc-flash calculations. Accurate protective device clearing times are essential for providing correct incident energy calculations and the resulting AF boundaries.

Accurate protective device clearing times are essential for providing correct incident energy calculations and the resulting AF boundaries.

While arc-flash calculations can be performed using standard operating times/characteristics of breakers and relays, this method does not insure conservative results and may compromise safety. Several examples showing this reasoning are provided below.
In Figure-8, the substation secondary main breaker provides selective coordination using either setting, however, the arc-flash incident energy is increased from 11 cal/cm to 29 cal/cm for the higher short time delay setting. This increases the PPE requirement from 3 to 4, significantly increasing costs, and the probability workers may try and bypass the higher PPE clothing requirements. This scenario is common to plants where an accurate protective device coordination study has never been performed, or where workers unfamiliar with protection system requirements make changes to protective device settings.
In this next example, Figure-9, the secondary main breaker is properly set, except the I²t function is left in. This raises the arc-flash incident energy from 11.0 cal/cm² to 16 cal/cm². If increased arcing impedance is modeled, reducing the arcing current to 80%, the incident energy is raised to over 20 cal/cm². This increase in energy can result in an increased cost of personal protective equipment and ongoing worker productivity losses associated with the increased PPE requirements.

In medium and high voltage systems, it is quite common to find relay settings that are set far above proper protective boundaries. This is especially true where new systems have been added to older systems, or where system studies have not been updated on a regular basis.

Figure-9
Figure-10 shows an older style induction disk relay providing protection to a 2400 volt MCC line-up. This unit must be set above the motor protective relays for selective coordination, but low enough to provide proper protection. A standard instantaneous unit cannot be used without tripping the entire lineup for a motor fault. The tap and time dial setting shown is a good compromise and typical of many systems. The unit will clear a bus fault in approximately 0.5 seconds (30 cycles). The arc-flash incident energy is over 30 cal/cm² and requires a PPE of 4. Using a new solid-state relay with delayed instantaneous setting for selective coordination, the incident energy is lowered to 10 cal/cm², greatly enhancing worker safety.
As can be seen proper protective device settings can greatly enhance worker safety, and system reliability. Performing an arc-flash assessment without first providing proper protection settings, can significantly impact the assessment.

**Arc Flash Calculations Using EasyPower**

In the previous steps, we have provided the basis for setting up the system model for proper arc-flash calculations. In this section we will provide the details for performing the actual arc-flash study and understanding the results, as well as some tricks of the trade.

Arc-flash calculations are performed in EasyPower’s short circuit focus. EasyPower’s SmartClick interface allows the users to simply double click any bus for instantaneous results, to fault selective buses, or to “Fault All” buses.

For the example below, Figure-11, select the Arc-Flash button on the EasyPower toolbar. Double click on a bus (in this case Bus-4), and results appear on the one-line.

![Figure-11](image)

Each protective device displays the required Arc-flash boundary, let through energy in cal/cm², and the PPE requirement at a user specified working distance.

The values displayed on the one-line are based on the let through energy of the protective device, i.e. the energy on the load side of the device, not the line side.

Note: The values displayed are based on the let through energy of the protective device, i.e. the energy on the load side of the device, not the line side. This important safety aspect must be understood when applying arc-flash results. When working on the line side of a protective device, i.e. the incoming terminals, breaker stabs, or incoming bus work, the incident energy on the line side must be found from the let through energy of the upstream device, not the device you are working on. For example, when working on the primary stabs of breaker BL-2, the incident energy available to the worker is found from the first upstream device protecting BL-2. This is the let-through energy of the secondary main device BL-1, which is 18.7 cal/cm². If the worker is working on the load side stabs of BL-2, the
let through energy is controlled by BL-2, and will be associated with that breaker, in this case, 10.4 cal/cm².

Figure-12 below shows the same system, but with a primary fuse protecting the buswork from the TX-2 secondary terminal through the primary or line side bus stabs of breaker BL-1. Work in this area will require a PPE level 4 requirement and be subject to a let through energy of 30.8 cal/cm².

![Figure-12](image_url)

When laying out your safety plan, keep in mind that you will always be working on either the line side (upstream) or load side (downstream) of a protective device.

Displaying the results graphically, EasyPower provides the user with a clear picture of line side and load side let through energies, as well as a visual indication of problem areas and correct clothing compliance. This information can be posted in the electrical room, providing workers with a clear picture of the system and the hazards that may not be as easily apparent with just stick on labels. With the click of a mouse, you can change system parameters and compare different operating scenarios. This provides valuable training information that helps engineers and electricians understand how system changes impact arc flash hazard ratings.

For most large studies, however, it is typically more efficient to display results in spreadsheet form, and print the “Arc-Flash” hazard warning labels for each device. To perform this operation, simply go to **Tools** → **Short Circuit Options** → **Arc-Flash Tab**, and check the Arc-Flash Spreadsheet in the “Create Report” section of the tab. See Figure-6.

Now instead of double clicking on the bus to initiate the fault, select **Fault All** from the toolbar, and then **Window** → **Arc Flash Hazard Report**. A spreadsheet similar to the one below will tile in the foreground of the window.
The EasyPower Arc-Flash spreadsheet provides all the data used in the calculations to determine AF Boundary, Incident energy, and PPE requirements for each protective device in the system. This data can be applied directly to comply with NEC 2002, and NFPA-70E by simply clicking on File ➔ Print Labels.

Before you print labels it is recommended that you refer to STEP-2, and review your modes of operation. It is highly recommended that you save your different operating modes in EasyPower’s Scenario Manager. This will allow you to refer to each case without affecting the base case system as you make changes and fine-tune your arc-flash assessment.

**Summary**

1) Run base case arc-flash calculations
2) Switch to different operating modes as defined in Scenario Manager.
3) Run arc-flash calculations for each operating mode to determine highest arc hazard.
4) Compare the highest incident energies from the base case and scenarios. Take the case with the highest values (there may be multiple cases for different parts of the system) and modify the arcing current to reflect a high impedance arcing current. This will lower the arcing current, which may cause longer trip times and result in higher incident energies. See STEP-2, and Figure-6. Note: A good starting place is 80% of the calculated arcing current. Going much lower than this may result in current values that cannot be realistically maintained.
5) Compare the incident energies of the case selected in task 4 above with the high impedance values with of the same case. Print labels.

The following labels can be printed on plastic stock through most laser printers, or via commercially available label printers. EasyPower provides direct output to selected label printers, help you avoid hours of data conversion routines.

The EasyPower Arc-Flash spreadsheet provides all the data used in the calculations to determine AF Boundary, Incident energy, and PPE requirements for each protective device in the system. This data can be applied directly to comply with NEC 2002, and NFPA-70E by simply clicking on File ➔ Print Labels.

Before you print labels it is recommended that you refer to STEP-2, and review your modes of operation. It is highly recommended that you save your different operating modes in EasyPower’s Scenario Manager. This will allow you to refer to each case without affecting the base case system as you make changes and fine-tune your arc-flash assessment.

**Summary**

1) Run base case arc-flash calculations
2) Switch to different operating modes as defined in Scenario Manager.
3) Run arc-flash calculations for each operating mode to determine highest arc hazard.
4) Compare the highest incident energies from the base case and scenarios. Take the case with the highest values (there may be multiple cases for different parts of the system) and modify the arcing current to reflect a high impedance arcing current. This will lower the arcing current, which may cause longer trip times and result in higher incident energies. See STEP-2, and Figure-6. Note: A good starting place is 80% of the calculated arcing current. Going much lower than this may result in current values that cannot be realistically maintained.
5) Compare the incident energies of the case selected in task 4 above with the high impedance values with of the same case. Print labels.

The following labels can be printed on plastic stock through most laser printers, or via commercially available label printers. EasyPower provides direct output to selected label printers, help you avoid hours of data conversion routines.
Economic Benefits

The economic benefits of performing arc-flash assessments using dedicated power system analysis software become readily apparent when the alternative is to use a spreadsheet calculator like those provided in IEEE-1584. Arc hazards assessment using a spreadsheet calculator requires the following tasks.

1) Transfer of data from short circuit program to the spreadsheet calculator. This includes short circuit calculations, bus names, and bus voltages.
2) Determine the arc gap for each calculation or equipment in the spreadsheet.
3) Determine the trip time for each device or bus in the spreadsheet. There are usually multiple trip times required for each bus.
4) Run the calculation
5) Apply NFPA-70 PPE requirements to each calculation.
6) Spreadsheet calculations DO NOT provide for a device-by-device analysis, unless the users accounts for each device in the system.
7) Perform the calculation for a change in tie breaker status or generation (mode of operation).
8) Take the highest results (case) and re-run using a higher impedance arcing fault to insure accurate results.

As can be seen, the man-hours required to perform an arc-flash assessment can be cost prohibitive using a spreadsheet calculator. When applied to large systems, such as those in the petrochemical or the pulp and paper industries, it becomes almost an impossibility. Another consideration is the potential for errors when applying all the hand calculations, trip time look-ups, and spreadsheet work.

EasyPower’s complete integration of short circuit, protective device coordination, and arc-flash can be exponential as compared to the use of an IEEE-1584 spreadsheet calculator. EasyPower simplifies the process, reduces human error and provides a basis from which system changes and modifications can be modeled and the study results updated immediately, without the extensive work and risk of error associated with a spreadsheet. EasyPower also helps with safety program requirements for accurate documentation, as it provides reports that become a key part of a corporate arc flash hazard safety program. The EasyPower ArcFlash program will also be kept up to date with the latest industry standards, helping to ensure the most accurate results.

Summary

This guide presents the basic steps for performing an arc-flash hazard assessment using power analysis software. Users performing arc-flash assessments should be aware that reduced short circuit currents can increase arc incident energies for some cases. They should also fully understand the arc-let through energies as applied to protective devices, before assigning arc-flash boundaries and incident energy ratings to equipment.

Power analysis software that provides complete one-line/analysis integration eliminates the separate steps required by other programs and integrates the short circuit, protective device, and arc hazard functions, greatly reducing the time, and effort to perform the analysis.

- Chet E. Davis, PE

Warning - Disclaimer: The calculation methods listed in the paper are based on theoretical equations derived from measured test results. The test results are a function of specific humidity, barometric pressure, temperature, arc distance, and many other variables. These parameters will not be the same in your facility or application. The results calculated from these equations may not produce conservative results when applied to your facility. PPE recommended by any calculation method will NOT provide complete protection for all arc hazards. Injury can be expected when wearing recommended PPE. The results should be applied only by engineers, experienced in the application of arc-flash hazards. EasyPower makes no warranty concerning the accuracy of these results as applied to real world scenarios.